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TAI LIEU DAY - HOC TIN HOC 7 - TAP MOT

ME SO oo, DTN
SODKXB : oo JCXBIPH ..o, /GD




LOI NOI DAU

Trong trao luu hoi nhap, cung véi ngoai ngl, Tin hoc la mét cong
cu khéng thé thiéu vai cac em hoc sinh. Trén tinh than do, S& Giao
duc va Dao tao Thanh phé H6 Chi Minh phéi hgp vai Nha xuat ban
Gido duc Viét Nam t6 chuic bién soan bo Tai liéu day - hoc Tin hoc
cap Trung hoc co s& v6i mong muén :

- H6 trg thay c6 gido va cac em hoc sinh trong viéc day - hoc Tin
hoc cap Trung hoc ¢ s& phu hop véi yéu ciu ctia Chudn kién
thuc, ki nang trong Chuong trinh gido duc phé théng ctia Bé
Gido duc va Pao tao.

- Noi dung bd tai liéu dugc cap nhat theo su phat trién cla
nganh Tin hoc dugc trinh bay theo tung chi dé&; mbi chu dé
bao gobm nhiéu hoat déng nham hinh thanh kién thic ti co
ban dén nang cao cho cacem.

- Viéc hoc li thuyét gan lién véi thuc hanh gitp hoc sinh c6 dugc
ki nang st dung may vi tinh dé€ phuc vu hoat déng hoc tap va
van dung kién thuc vao thuc tién.

Vi tai liéu nay, hi vong cac thay cé gido sé c6 thém lua chon dé ap

dung vao viéc gidng day tai don vi, dia phuong clia minh va gilp

cac em hoc sinh nang cao khd nang tu hoc, ty rén luyén ki ndng
thuc hanh trén may vi tinh.

Chung t6i rat mong nhan dugc su phan hoi, déong gop y kién cla

cac thay 6 gido, phu huynh cung cac em hoc sinh dé bé sach

dugc hoan thién hon.

Nhoém bién soan
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MUC TIEU

- Néu dugc cac cong viéc sir dung bang tinh trong hoc tap va dgi séng.
- Néu dugc mot sé tinh nang clia chuong trinh bang tinh.

- Nhan biét moét s6 thanh phan co ban trén man hinh bang tinh.

- S dung dugc cac khai niém vé hang, cét, khoi va dia chi 6 tinh.
—Thuc hién cac thao tac co ban trén chuong trinh bang tinh.

A.KHGI PONG

Trong cudc séng, ching ta gip rat nhiéu loai bang biéu nhu: thoi khoa biéu 16p, bang diém
hoc sinh, hod don mua hang, ...

THOT KHOA BIEU

Chao oo Todn Negl vin D Lich sir Mpilr vin

SHL Hog Ng@ van Toén Am nhac | Sinh hge

Bria Sinh hoe Todn Céng nghé |  Vitli Lich st
Anh van Tin hge Todn GDCD Anh vin | Anh vin
NGLL Tin hoe Mgl vin Bia li TD

Hinh 1.1. Thai khod biéu

Thoi khoa biéu 1a mot dang bang biéu khong c6 dit liéu tinh toan. Nhung trong thuc té
nhiéu thong tin dang bang can dugc tinh toan nhu bang diém 16p, hoa don ban hang, phiéu
diém hoc tap cda hoc sinh, bang thi dua, ...
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Hinh 1.2. Badng diém I6p




((_ Hoat dong D

Hay danh dau X vao 6 thich hop cho cac thong tin dang bang c6 thuc hién tinh toan hoic
khong c6 thuc hién tinh toan.

Cac loai bang Bang thong tin Bang thong tin
trong thuec te c6 tinh toan khong c6 tinh toan
Thoi khoa biéu
Bang luong hang thang
Danh sach 16p

Hoé don ban hang

Lich thi hoc ki

Hoa don tién dién

Bang diém ca nam hoc

bé lam viéc véi cac bang dir liu tinh toan, ching ta c6 thé str dung cac phan mém tinh toan
trén may vi tinh. Cac phan mém nay goi chung la phan mém bang tinh.

Ban c6 thé sir dung phan mém bang tinh dé tao ra cac bang tinh gitp ich trong hoc tap va doi song.
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Hinh 1.3. Lap bang bao cdo doanh sé.

Phan mém bang tinh gitp tao biéu dd minh hoa truc quan sé hoc sinh gioi khéi 7.

56 HOC SINH GIOI KHE) 7

Tl ad TA Tl T

Hinh 1.4. Bi€u d6 biéu dién s hoc sinh gidi khéi 7




Q Hoat dong D

Vi sao dé tao céc bang dir liéu c6 thuc hién tinh todn nguoi ta thuong su dung phén mém
bang tinh?

B. KIEN THUC

Dé tao cac bang biéu can thyc hién tinh toan, ban co thé sir dung phan mém bang tinh co tén
goi Microsoft Excel (goi tit 1a Excel). Excel 1a mot phin mém bang tinh ctia hing Microsoft
duoc st dung rong rai nhiéu ndm qua. Excel dugc cap nhat lién tuc va hién nay co nhiéu phién
ban. Sau ddy chung ta hiy 1am quen v6i phan mém Excel phién ban 2010.

1. Khéi dong chuong trinh bang tinh Excel
C6 nhiéu cach dé khai dong Excel, sau ddy 1a hai cach thudng duoc sir dung:
Cach 1:

Nhay nut Start - chon All Program - chon Microsoft Office >hodc chon Microsoft Excel
2010.

Cach 2:

=

X

Trén man hinh Desktop, nhay dup chudt vao biéu tugng Microsoft Excel 2010 | “* ).
Céc tap tin do Excel tao ra dugc goi 1a cac bang tinh (Workbook).

2. Man hinh lam viéc

Sau khi khéi dong, cura s6 man hinh Excel xut hién. Ngoai thanh bang chon, thanh cong cu
chuan, thanh cong cu dinh dang, ... nhu phﬁn mém soan thao vin ban thi man hinh Excel
con co cac thanh phﬁn chinh nhu bang chon Data, hdp tén, thanh cong thire, trang tinh,
thanh Ribbon.

Man hinh lam viéc Excel 2010:
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Hinh 1.5. Man hinh lam viéc Excel 2010

— Thanh Ribbon: Bao gdm cic nhom 1énh hién thi ngay trén man hinh, giup viéc sir dung cac

nut 1énh dé dang hon.
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Hinh 1.6. Thanh Ribbon dang trinh bay bang chon Home

— Thanh cong thire: Puge sir dung dé nhap, hién thi dir liéu hodc cong thirc trong 6. Py 1a
thanh cong cu dic trung cua chuong trinh bang tinh.

— Hop tén: Bén trai thanh cong thire, hién thi dja chi 6 dang duoc chon.

! Al vl F | v |

Hinh 1.7. Hop tén hién thi dia chi 6 A1 dang dugc chon.

Mot bang tinh (Workbook) c6 mot hodc nhiéu trang tinh (Worksheet). Mac dinh, khi tao mot
bang tinh m&i, ta c6 ba trang tinh dwgc tao sdn. Mdi trang tinh déu c6 mot tén dé phan biét voi
trang tinh khac. Méc dinh trang tinh c6 tén la Sheetl, Sheet2, Sheet3,...



— Trang tinh: gdm céc cdt va cac hang la mién lam viéc chinh ctia bang tinh.
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Hinh 1.8.Trang tinh Sheet1

Tén cdt cua trang tinh bit ddu bang cac chit cai A, B, C, ...

Tén hang cuia trang tinh bat dau bﬁng cac s6 1,2,3,....

Giao giita mot cot va mot hang goi 13 6. O dung dé chua dix liéu. Mdi 6 c6 mdt tén goi la dia
chi 6. Dja chi 6 bao gdm tén cot va tén hang cta 6 do.

Vidu 4:
Al la dia chi 6 cua cot A va hang 1.
B10 1a dia chi 6 cua cdt B va hang 10.

((_ Hoat dong D

Hay liét ké tén cac trang tinh va dia chi 6 dugc
ké 6 trong hinh 1.9 dudi day:

Hinh 1.9




3. M6t s6 thao tac co ban

e Mo bang tinh mdi

C6 thé chon mot trong cac cach sau dé m& mot bang tinh mai:
— Nhay nut 1énh D trén thanh cong cu.

— Nhay bang chon File, chon New.

— Nhan t6 hop phim Ctrl+N.

e Luu bang tinh

Co6 thé thuc hién luu bang tinh trong khi nhép dit li¢u bﬁng mot trong cac cach sau:
— Nhay nut 1énh H trén thanh cong cu.

— Nhay bang chon File->Save.

— Nhén t6 hop phim Ctrl+S.

Hop thoai Save As xuat hién nhu hinh 1.10, thuc hién cac budc sau:
+ Chon 6 dia, thu muc chaa tap tin can luu.

+ G0 tén tap tin.

+ Nhan nut 1énh Save.
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Hinh 1.10. HOp thoai luu bang tinh

Céc tap tin bang tinh c6 phan dudi ngam dinh 13 .xlsx.

Néu mudn luu bang tinh véi tén khac, mé bang chon File chon 1énh Save As, cac budc thuc
hién tuwong ty nhu luu mot bang tinh maoi.




e Mo bang tinh da co
C6 thé chon mét trong cac cach sau dé mo mot bang tinh da dugc luu trude d6 hodc co san
trén may vi tinh:
ea
—Nhay nat 1énh |/ trén thanh cong cu.
— Nhay bang chon File, chon Open.
— Nhén t6 hop phim Ctrl+O.

Hop thoai Open xuét hién nhu hinh 1.11, thuc hién cac bude sau:
+ Chon 6 dia, thu muc chira tap tin can mé tap tin.

+ Chon tén tép tin.

+ Nhan nat 1énh Open.
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Hinh 1.11. HOp thoai m& bang tinh

e Dong bang tinh

— Pong bang tinh dang md: nhay vao bang chon File, chon Close hoac nhéan nat 1énh *® hoac
nhan t6 hop phim Ctrl + F4.

— Déng Excel: nhay bang chon File, chon Exit hoic nhan 1&nh 838 hoic nhén t6 hop phim
Alt + F4.
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Hay dién céc thao téc thich hop vao bang dudi day:

Y nghia Thao tac thwe hién Phim tit
Mo bang tinh méi File > New Ctrl + N
Mo bang tinh da co
Luu bang tinh

Luu bang tinh véi tén khac

Pong bang tinh dang mo

Pong phan mém Excel

C. VAN DUNG VA LUYEN TAP

1. Chuong trinh bang tinh thuong dugc sir dung dé:
a) Tao bang tinh, thyc hién tinh toan, sip xép va loc dit liéu.
b) Tao va xt li biéu dd, sip xép va loc dir lidu.
¢) Tao bang tinh, thyuc hién tinh toan, tao va xu 1i biéu dd, sap xép va loc dit lidu.

d) Tao bang tinh, sip xép va loc dir liéu, tao va xir li biéu do.

2. Trang tinh bao gom:
a) Cac cot va cac hang.
b) Thanh cong cu va thanh cong thirc.
¢) Thanh tiéu dé, céac cOt, cac hang.

d) Cac bang chon va thanh cong thtrc.
3. Mic dinh bang tinh c6 bao nhiéu trang tinh?
a)l b) 2 c)3 d)4

4. Giao cua mot cot va mot hang goi la:
a) Cot b) Hang c)O d) Khéi

5. Dia chi 6 nao sau day khong dung?
a) 1A b) A100 ¢) AA2 d) A2




6. Thanh cong thirc dugc st dung dé:
a) Nhap dir liéu vao 6.
b) Hién thi cong thirc trong 6.
¢) Hién thi dia chi 6 c¢6 cong thirc.

d) Pé nhap, hién thi dir liéu hodc cong thirc ¢6 trong 6.

7. Dé luu bang tinh hién tai vao dia, thyuc hién énh:
a) Nhén t6 hop phim Ctrl+S
b) Insert > Save
c¢) File>Save
d) Ca a, ¢ déu dung.

8. Hay dién vao chd tréng (...) dé hoan thanh doan van béan sau:

Céc tap tin do Excel tao ra dugc goi la cdc ............cooeiinitn. Mot bang tinh c6 mot
hodc nhidu ..........coeevvn.. MB&i trang tinh déu c6 mot tén. Mic dinh, khi tao mot bang
tinh mdi, taco ....... trang tinh dugc tao ra san.

9. Hay nbi cac ndi dung trong cot A v6i ndi dung twong tmg trong cot B

A B
1. Céc cot cua trang tinh duoc ki hiu 1a a) cac cot va cac hang
2. Ki hiéu dia chi ctia 6 ¢ c6t C hang 25 1a b)1,2,3,...
3. Céc hang cua trang tinh duoc ki hi¢u la c) o
4. Trang tinh bao gém d)A,B,C, ...
5. Giao cua cdt va hang duoc goi la e) C25

10. Hay ké tén céc trang tinh trong hinh sau:

)
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Hinh 1.12




11. Cho bang tinh nhu hinh 1.13, hay tra 161 cac cau hoi sau:

C4] A B | ¢ | o | E N ) -
1
2 HOA BON BAN HANG
3
4 STT| Teénhang |S6lwgng| Don gia Thanh tién
s 1 |Dia DVD tréng 100 5000 500000
E 2 |Head phone 20 20000 1800000
; 3 |usB 15 120000 1800000
8 4 |Mouse 20 T0000 1400000
s 5 |Keyboard 20 110000 2200000
" Téngcdng| 7700000
M
12
Hinh 1.13

a) Hay liét ké tén céc cdt, cac hang co dir lidu.




BAITHUC HANH 1

A.KHG1 DONG

e Khoi dong Excel.
e M cac bang chon va quan sat cac 1énh c6 trong bang chon do.

e Dong chuong trinh Excel.

B. VAN DUNG VA LUYEN TAP

1. Di chuyén trén trang tinh

e Khoi dong Excel bang nhiéu cach.

e St dung cac phim miii tén | T — « trén ban phim dé di chuyén giira cac 6 trén trang tinh.
Str dung chudt dé chon céac 6: A4, B10, C15, H17, K14.

St dung thanh cudn doc va thanh cudn ngang dé di chuyén dén cac 6 ngoai pham vi man
hinh nhu Y20, V100, AAS, IV1.

e St dung hop tén: di chuyén dén mot 6 bat ki trong trang tinh bang cach st dung hop tén.
— Nhay chudt vao hop tén.

— G0 dia chi 6.

— Nhan phim Enter dé két thuc.

Hinh 1.14 minh hoa cac budc kich hoat 6 C100 bang hop tén.

mu||-n

Hinh 1.14

e Quan sat cac cach di chuyén trén trang tinh va cho nhan xét.

e Thoat khoi Excel ma khong Iuu nhitng ndi dung da thuc hién.



2. Pién sé thu tu

Hay thuc hién cac budc sau dé dién s thi tu vao 6 tinh.

e Chon trang tinh Sheetl, gd cac s6 tir 1 dén 40 vao cac 6 cta cot A. Ban sé& thiy rang cong
viéc nhap s thir tu nay rat don gian nhung lai mat rat nhiéu thoi gian.

e Dé nhap sb thr tu tir 1 dén 20 vao cot A, co thé thuc hién cac budc sau:

— Nhap s6 1 vao 6 A1, nhap s6 2 vao 6 A2.

— Chon 6 Al va 6 A2, dua con trd chudt vao diu ' A B
méc didn (d5u chim den'bén phéi phia d6i 6 A2) i 1
dén khi con tr6 chut xuit hién hinh déu + _g_ 2
— Kéo chudt xudng cic 6 & cot A cho dén khi xut 1]
hién so 20 thi nha chudt ra.
Hinh 1.15

e Tuong tu, hdy thuc hién cac thao tac dé trang tinh c6 dir liéu nhu hinh 1.16.
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Hinh 1.16

e Luu bang tinh véi tén Bai tap 1.




C.TiIMTOI VA MG RONG
3. Thém trang tinh mgi

C6 thé thuc hién bﬁng cac cach sau dé thém
trang tinh mé&i vao bang tinh:

Cach 1: Nhay chon nut 1énh thém trang tinh
nhu hinh 1.17, mot trang tinh méi s& xuét hién
& vi tri cudi cing.

Cach 2: Nhay chudt phai trén tén trang tinh
- chon Insert, mot trang tinh méi xuat hién
trude trang tinh dang chon.

Céch 3: Nhan t6 hgp phim Shift + F11

4. Doi tén trang tinh

Mic dinh tén trang tinh 1a Sheetl, Sheet2,...
Ban c6 thé ddi tén trang tinh dé d& phan biét,
dé nhd bang cac cach sau:

Céach 1: Hay thuc hién tuan tu cac thao tac sau:
— Chon trang tinh can dbi tén, nhay chudt phai
trén tén trang tinh = chon Rename

— G& tén trang tinh m&i va nhan phim Enter
dé két thic.

Cach 2: Nhay dup chudt vao tén trang tinh,
g0 tén trang tinh méi va nhan phim Enter dé
két thic.

e Pong Excel va khong luu nhiing thay doi.
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Hinh 1.18

[ Insert...
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Hinh 1.19

Sheer? - Sheets |, TJ

Hinh 1.20
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